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Chapter 1

About this Guide

This Uset's Guide provides information on how to prepate custom Virtual Analyzer
images in the following topics:

OV’A File Creation Using New Virtual Machine Images on page 2-1

OVA File Creation Using Converted 1 irtual Hard Disk Drives on page 3-1

Virtual Analyzer Image Preparation Tool on page 4-1
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Document Conventions

The documentation uses the following conventions:

TABLE 1-1. Document Conventions

CONVENTION DESCRIPTION
UPPER CASE Acronyms, abbreviations, and names of certain
commands and keys on the keyboard
Bold Menus and menu commands, command buttons, tabs,
and options
Italics References to other documents
Monospace Sample command lines, program code, web URLs, file

names, and program output

Navigation > Path

The navigation path to reach a particular screen

For example, File > Save means, click File and then click
Save on the interface

ﬁ’ Note

Configuration notes

Q Tip

Recommendations or suggestions

O Important
L.

Information regarding required or default configuration
settings and product limitations

ﬁ WARNING!

Critical actions and configuration options




About this Guide

Audience

This User Guide is intended for administrators who need to create custom sandbox
images for Virtual Analyzer. The document assumes a working knowledge of networks
and information security, including the following topics:

+  Deploying and administering Deep Discovery or TippingPoint products

+  Using Oracle VM VirtualBox™ or VMware™ products

Terminology
TERMINOLOGY DESCRIPTION
Open Virtual A ready-to-use software package (operating system with
Appliance (OVA) applications) that does not require additional configuration or
installation. Virtual Analyzer supports only image files in the Open
Virtual Appliance (OVA) format.
Sandbox image A template used to deploy sandbox instances in Virtual Analyzer.

A sandbox image includes an operating system, installed
software, and other settings necessary for that specific computing
environment.

Sandbox instance A single virtual machine based on a sandbox image.

Virtual Analyzer A secure virtual environment that manages and analyzes objects
submitted by integrated products and administrators. During

analysis, Virtual Analyzer rates the characteristics in context and
then assigns a risk level to the object based on the accumulated

ratings.
Virtual Analyzer A collection of utilities that execute and detect malware, and
Sensors record all behavior in Virtual Analyzer.
Virtual Machine A file format used in virtual machines like VMware Workstation or

Disk (*.vmdk) Oracle VM VirtualBox.
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Chapter 2

OVA File Creation Using New Virtual
Machine Images

Learn how to create a Virtual Analyzer-supported OVA file in the following topics:

Downloading and Installing VirtualBox on page 2-5
Creating Virtual Machine Images on page 2-6
Modifying the Virtual Machine Environment on page 2-24

Reducing the Size of VirtualBox Disk Images on page 2-32

Exporting Virtnal Machine Images to OV A Files on page 2-33
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Creating OVA Files Using New Virtual Machine
Images

Procedure
1. Prepare the operating system and required applications.
For details, see Required Software on page 2-2.
2.  Download and install VirtualBox.
For details, see Downloading and Installing VirtualBox on page 2-5.
3. Create a virtual machine image.
For details, see Creating Virtual Machine Images on page 2-6.
4.  Modify the environment of the virtual machine image.
For details, see Modifying the Virtual Machine Environment on page 2-24.
5. Reduce the size of the VirtualBox Disk Image.
For details, see Reducing the Size of VirtualBox Disk Images on page 2-32.
6. Export the virtual machine image to an OVA file.

For details, see Exporting 1irtnal Machine Images to OV A Files on page 2-33.

Required Software

The following software must be installed on the virtual machine to achieve satisfactory

detection results.
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TABLE 2-1. Required Applications

SOFTWARE DESCRIPTION
Operating system Virtual Analyzer supports the following operating systems:
Windows XP
Windows 7

Windows 8/8.1

Windows 10 RS3 and before
+  Windows Server 2003/2003 R2
+  Windows Server 2008/2008 R2
«  Windows Server 2012/2012 R2
+  Windows Server 2016

O Important
<«

«  Package the installer as an ISO file.

«  Activate Windows with a valid product key after the
Virtual Analyzer Image Preparation Tool has validated
and modified virtual machine settings. Do not activate
Windows before that.

«  Use a computer name that reflects your organizations'
naming scheme.

- Disable automatic updates.

+  Trend Micro recommends using the English version of
the listed operating systems.
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SOFTWARE DESCRIPTION

Office suite Virtual Analyzer supports the following office suites:
Office 2003 (32-bit)

Office 2007 (32-bit)

Office 2010 (32-bit and 64-bit)

Office 2013 (32-bit and 64-bit)

Office 2016 (32-bit and 64-bit)

Office 365 (32-bit and 64-bit)

O Important
<«

. Microsoft Word, Microsoft Excel, Microsoft PowerPoint,
and Microsoft Publisher must be installed.

- Activate Microsoft Office with a valid product key after
the Virtual Analyzer Image Preparation Tool has
validated and modified virtual machine settings. Do not
activate Microsoft Office before that.

- After installation, open all Microsoft Office applications
and verify that the main editing screen is displayed. If
any confirmation dialog or welcome screen displays,
make any selection to close the screen and display the
main editing screen.

Welcome to Microsoft Office 2010 =

Help Protect and Improve Microsoft Office ,J&Oﬂ:lE“é

se Recommended Settings

jonal Office 2nd
ms, automaticaly

o Install Updates Only

O Instal impertantand for Office, Windons and Offer me new and
Microsoft software.

° Don't make changes

© Choosing this aption couid expose your computer to security threats.

FIGURE 2-1. Help Protect and Improve Microsoft
Office

Verify that your license allows you to virtualize the
applications. For details, see https://suppo |



https://support.office.com
https://support.office.com/en-us/article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
https://support.office.com/en-us/article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6

OVA File Creation Using New Virtual Machine Images

SOFTWARE DESCRIPTION

Adobe Reader Install the version of Adobe Reader that is most widely used in
your organization. To download the most current version of Adobe
Reader, go to http://www.adobe.com/downloads/.

If you do not install Adobe Reader, Virtual Analyzer:

Installs Adobe Reader 8, 9, and 11 on all Windows XP and
Windows Server 2003/2003 R2 images during importing.

+ Installs Adobe Reader 9, 11, and DC on all Windows 7 and
newer images during import.

Uses all versions during analysis.

WARNING!

This consumes additional computing resources.

+ Installs .NET Framework 3.5 or later if the operating system
is Windows XP or Windows Server 2003.

Configure Adobe Reader to manually check for and install
updates. For details, see https://helpx.adobe.com/acrobat/kb/
reader-acrobat-updater-settings.html.

O Important
L *

Do not install VMware tools to avoid triggering the anti-virtual machine functions of some
malware.

Downloading and Installing VirtualBox

Procedure

1. Download the latest version of VirtualBox from https://www.virtualbox.org

wiki/Downloads.



http://www.adobe.com/downloads/
https://helpx.adobe.com/acrobat/kb/reader-acrobat-updater-settings.html
https://helpx.adobe.com/acrobat/kb/reader-acrobat-updater-settings.html
https://www.virtualbox.org/wiki/Downloads
https://www.virtualbox.org/wiki/Downloads
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Note

The VirtualBox Open Source Edition is licensed under the GPL V2. The full text of
the license is available at http://www.gnu.org/licenses/old-licenses/gpl-2.0.html.

2.  Configure the language settings using one of the following methods:
+  Install VirtualBox with English as the default language.

. After installation, go to File > Preferences > Language and then select

Language: English (built-in)
Proxy Author(s): Oracle Corporation

English.
&P VirtualBox - Preferences ? *
E General Language
@ Input Interface Languages
Default ”
@ Update English (built-in}
@ Bahasa Indonesia
Language | | o115
@ Displ Cettina
spay Dansk
@ Metwork Deutsch (Deutschland)
Espariol
D Extensions Fuskara ~

Cancel

FIGURE 2-2. Language Settings

Creating Virtual Machine Images

Procedure

1.  Open VirtualBox.



http://www.gnu.org/licenses/old-licenses/gpl-2.0.html
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The VirtualBox Manager window opens.

¥ Oracle UM VirtualBox Manager - m} X

¢ AR Gap

Preferences  Import Export New Add

File Machine Help

‘Welcome to VirtualBox!

The left part of application window contains global tools and
lists all virtual machines and virtual machine groups on your
computer. You can import, add and create new YMs using
corresponding toolbar buttons. You can popup a tools of
currently selected element using corresponding element
button.

You can press the FL key to getinstant help, or visit
www.virtualbox.org for more information and latest news.

FIGURE 2-3. VirtualBox Manager

2. Click New.
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The Create Virtual Machine window opens.

Create Virtual Machine

Name and operating system

Please choose a descriptive name and destination folder for the new virtual
machine and select the type of operating system you intend to install on it.
The name you choose will be used throughout VirtualBox to identify this

machine.

Name: || |
Machine Folder: | D:VWirtualBox VMs b |
[ : B g

Type: |Microsoft Windows i
Wi

Version: | Windows 10 (54-bit) 7

Expert Mode Mext Cancel

FIGURE 2-4. Create Virtual Machine

3. On the Name and operating system screen, configure the following:
+  Name: Type a permanent name for the virtual machine.
«  Type: Select Microsoft Windows.

. Version: Select Windows XP, Windows 2003, Windows 7, Windows 8,
Windows 8.1, Windows 10, Windows 2008 /2008 R2, Windows 2012/2012
R2 or Windows 2016.

4. Click Next.




OVA File Creation Using New Virtual Machine Images

The Memory size screen appears.

Create Virtual Machine

Memory size

Select the amount of memory (RAM) in megabytes to be allocated to the
wirtual machine.

The recommended memory size is 2048 MEB,

0 24 [ e

4 MB 32768 MB

FIGURE 2-5. Memory Size
5. Specify the recommended memory size for your operating system.
+  Windows XP and Windows Server 2003: 512 MB

. Windows 7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2 and Windows Server 2016: 1024 MB

6. Click Next.
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The Hard disk screen appears.

Create Virtual Machine

Hard disk

If you wish you can add a virtual hard disk to the new machine, You can
either create a new hard disk file or select one from the list or from another

|ocation using the folder icon.

If you need a more complex storage set-up you can skip this step and make
the changes to the machine settings once the machine is created.

The recommended size of the hard disk is 50,00 GB.

) Do not add a virtual hard disk
(® Create a virtual hard disk now
() Use an existing virtual hard disk file

Empty

FIGURE 2-6. Hard Disk

7. Select Create a virtual hard disk now and then click Create.
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The Hard disk file type screen appears.

Create Virtual Hard Disk

Hard disk file type

Please choose the type of file that you would like to use for the new virtual
hard disk. If you do not need to use it with other virtualization software you
can leave this setting unchanged.

() DI (VirtualBox Disk Image)
() WHD {virtual Hard Digk)
(® VMDK (virtual Machine Disk)

Expert Mode Cancel

FIGURE 2-7. Hard Disk File Type

8.  Select VDI (VirtualBox Disk Image) or VMDK (Virtual Machine Disk) and
then click Next.
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The Storage on physical hard disk screen appears.

€ Create Virtual Hard Disk

Storage on physical hard disk

Please choose whether the new virtual hard disk file should grow as it is used
{dyrnamically allocated) or if it should be created at its maximum size (fixed
size).

A dynamically allocated hard disk file will only use space on your physical
hard disk as it fills up {up to a maximum fixed size), although it will not shrink
again automatically when space on it is freed.

& ficed size hard disk file may take longer to create on some systems but is
often faster to use,

You can also choose to split the hard disk file into several files of up to two
gigabytes each. This is mainly useful if vou wish to store the virtual machine an
removable USE devices or old systems, some of which cannot handle very large
files.

(® Dynamically allocated
() Fixed size
] split into files of less than 2GE

FIGURE 2-8. Storage on Physical Hard Disk

9. Select Dynamically allocated and then click Next.

O Important
\ ¢

Do not select Fixed size or Split into files of less than 2GB.
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The File location and size screen appears.

€ Create Virtual Hard Disk

File location and size

Please type the name of the new virtual hard disk file into the box below or didk
an the folder icon to select a different folder to create the file in.

win10_office2016_x54 | Ea

Select the size of the virtual hard disk in megabytes. This size is the limit on the
amount of file data that a virtual machine will be able to store on the hard disk,

]

4,00 MB 2.00TE

FIGURE 2-9. File Location and Size
10. (Optional) Click the folder icon to change the path of the virtual disk file.

11.  Specify the recommended virtual disk size for your operating system.

. Windows XP and Windows Server 2003: 15 GB
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. Windows 7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2 and Windows Server 2016: 25 GB

12. Click Create.

VirtualBox creates the virtual machine. The new virtual machine appears in the left
pane of the VirtualBox Manager screen.

¥ Oracle UM VirtualBox Manager - m} x

File Machine Help

HE'E Tools {:} {E} g -
New Settngs Discard  Start
= 0 office2016 =] General =) preview
0 @ Powered Off Mame: win10_office2016_x64
Operating System: ~ Windows 10 (54-bit)
Settings File Location:  D:\WirtualBox YMs
\in10_office2016_x64

[&] system winl0_office2016_x64

Base Memory: 1024 MB

BootOrder:  Floppy, Optical, Hard Disk

Acceleration:  VT-x/AMD-V, Nested Paging, Hyper-V
Paravirtualization

[®) pisplay
video Memary: 128 MB
Graphics Controller: VBoxSVGA

Remote Desktop Server:  Disabled
Recording: Disabled

Storage

Controller: SATA
SATAPort0:  win10_office2016_x64,ymdk (Normal, 25.00 GB)
SATAPort 1:  [Optical Drive] Empty

fp Audio

HostDriver:  Windows Directsound
Controller:  Intel HD Audio

EP Network
Adapter 1:  Intel PRO/1000 MT Desktop (NAT)

[ usB

USB Controller:  OHCI
Device Filters: 0 (0 active)

[ Shared folders
Mone
&) Description

None

FIGURE 2-10. Newly-created Virtual Machine

13. Click Settings.
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The Settings window opens.

) win10_office2016_x64 - Settings ? X
E General General

IEI System Basic Advanced Description Disk Encryption

B Display Mame: |win10_office2016_x64 |
Storage Type: | Microsoft Windows -

Version: | Windows 10 (64-bit) -

(D: Audio

@ Metwork

@ Serial Ports

ﬁ USE

D Shared Folders

EI User Interface

Cancel

FIGURE 2-11. VirtualBox Settings

14. In the left pane, click System.
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15.

16.
17.

The System screen appears.

) win10_office2016_x64 - Settings ? X
E General System
@ System Motherboard  Processor  Acceleration
B Display Base Memory: ' 1024MB |+
4ME 32768 MB
Storage
L]
. Boot Order: Floppy
(‘DII Audio ® Optical
Hard Disk
@ Metwork O @ Network
@ Serial Ports Chipset: | ICH9 hd
ﬁ USE Pointing Device: | USE Tablet A
Ij Extended Features: Enable 1/ APIC
Shared Fold
ared rolders [ Enable EFI (special OSes only)
EI User Interface [ Hardware Clock in UTC Time

Cancel

FIGURE 2-12. System Screen

On the Motherboard tab, configure the following:

«  Chipset: Select ICH9

+  Pointing Device: Select USB Tablet

. Extended Features: Select Enable I/0O APIC

Go to the Processor tab and then select Enable PAE /NX.

Go to the Acceleration tab and then select Enable VT-x/AMD-V and Enable
Nested Paging.




OVA File Creation Using New Virtual Machine Images

ﬁ Note

The Acceleration tab is only available if the processor of the host system supports
virtualization technology and the virtualization setting is enabled in the BIOS of the
host system.

18. In the left pane, click Storage.

The Storage screen appears.

23 win10_office2016_x64 - Settings ? X

E General Storage

Devi Attributes

System Sto

Name: [SATA |

Display ;
Bl winio_office2016_xe4.vmdk Type: | AHCI 4

St
e © Empty Part Count: |2 =
Audio [ Use Host IO Cache

Metwork

Serial Ports

USB

Shared Folders

ADRPHBTENE

User Interface

@

Cancel

FIGURE 2-13. Storage Screen

19. (Optional) If Controller: SATA appears under Storage Tree, remove the SATA
controller and then add the virtual hard drive to the IDE controller.

a.  Click Controller: SATA and then click € to remove the default controller.

b.  Click Controller: IDE and then click [gh.
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The following message appears:

23 VirtualBox - Question ? >

You are about to add a virtual hard disk to
controller IDE.

Would you like to create a new, empty file to
hold the disk contents or select an existing one?

Create new disk  |Choose existing diskl Cancel

FIGURE 2-14. Choose Existing Disk

c.  Click Choose existing disk and then select the virtual hard disk file that you
previously created.

d.  Under Attributes, retain all default settings.

e.  Under Storage Tree, click Controller: IDE and then click the empty optical
drive icon.

f. Under Attributes, verify that CD/DVD Drive is IDE Secondary Master.
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€23 win10_office2016_x64 - Settings ? ®
E General Storage
IE‘ System Storage Devices Attributes
|E| Disal @ Controller: IDE Optical Drive: | IDE Secondary Master hd @l
Isplay
win10_office2016_x64.vmdk [ Live co/ovD

Storage @ Empty Information

Type: —
(D] Audio b

Size: —
@ Network Location: —

Attached to: —

@ Serial Ports
ﬁ USB
Ij Shared Folders
EI User Interface

@@=

Cnc

FIGURE 2-15. IDE Secondary Master

20. Under Attributes, click (=), and then select Choose a virtual CD/DVD disk
file....

21. Select the ISO file containing the operating system installer.

The ISO file is available as a device.

22. (Optional) In the left pane, click Audio and verify that Enable Audio is enabled.
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Shared Folders

23 win10_office2016_x64 - Settings ? X
E General Audio

E‘ System Enable Audio

|§| . Host Audio Driver: | Windows DirectSound A

Display
Audio Controller: | Intel HD Audio A
Storage
Extended Features: Enable Audio Output

(D:I Audio [ Enable Audio Input

@ Metwork

@ Serial Ports

ﬁ USB

User Interface

Cancel

FIGURE 2-16. Audio Options Settings
23. In the left pane, click USB and then select Enable USB Controller.

Q Important
oy . .
Verify that USB 1.1 (OHCI) Controller is selected.
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23 win10_office2016_x64 - Settings ? X
E General uUsB
E‘ System Enable USE Controller
) (@ USB 1.1 (OHCI) Controller
|§| Display
(C) USB 2.0 (EHCI) Controller
Storage (0) USB 3.0 (xHCI) Controller
. ice Filters
(D:I Audio USE Device Fi
@ Metwork @
@ Serial Ports
ﬁ Use
D Shared Folders
EI User Interface
Cancel

FIGURE 2-17. Enable USB Controller

24. In the left pane, click Shared Folders and then verify that no folders ate shared.
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Shared Folders

£ win10_office2016_x64 - Settings ? X
g

E General Shared Folders

li‘ System Shared Folders

i Mame Path Access Auto Mount At [a

|§| Display )
Machine Folders

Storage

(DJ Audio

@ Metwork

@ Serial Ports

ﬁ USB

User Interface

Cancel

FIGURE 2-18. Shared Folders Settings
25. Click OK.

The Settings window closes.

26. On the VirtualBox Manager screen, click e to power on the image.
Start
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¥ Oracle UM VirtualBox Manager

File Machine Help

i e

New Settings Discard

=] General

Mame: win10_office2016_x64

Operating System:  Windows 10 (54-bit)

Settings File Location:  D:WirtualBox YMs
\nin10_office2015_x64

=) preview

[ system win10_office2016_x64
Base Memory: 1024 MB
BootOrder:  Floppy, Optical, Hard Disk
Chipset Type:  ICH
Acceleration:  VT-x/AMD-V, Nested Paging, PAE/NX,
Hyper-¥ Paravirtuaization
=] pisplay
Video Memory: 128 MB

Graphics Controller: VBOXSVGA

Remote Desktop Server: Disabled

Recording: Disabled

Storage

Controller: IDE
IDE Primary Master:  win10_office2016_x64,vmdk (Normal, 25.00 GB)
IDE Secondary Master:  [Optical Drive] Empty

fp Audio

HostDriver:  Windows Directsound
Controller:  Intel HD Audio

EP Network
Adapter 1:  Intel PRO/1000 MT Desktop (NAT)

[ usB

USB Controller:  OHCI
Device Filters: 0 (0 active)

[ Shared folders
Mone
&) Description

None

FIGURE 2-19. VirtualBox Manager

The installation process starts.

27. Follow the on-screen instructions to install the guest operating system.
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+4 Windows Setup

&R Windows’

all: (English (United States) -
B8 English (United States) >

Enter your language and other preferences and click "Next” to continue.

served

FIGURE 2-20. Operating System Installation Process

28. Install Microsoft Office and other software to achieve satisfactory detection results.

Modifying the Virtual Machine Environment

Modify the virtual machine environment to run Virtual Analyzer Sensors, a collection of
utilities that execute and detect malware, and record all behavior in Virtual Analyzer.

« Modifying the Virtual Machine Environment (Windows XP and Windows Server 2003) on
page 2-25

. Modifying the Virtual Machine Environment (Windows 7/8/8.1/10, Windows Server
2008/ 2008 R2, Windows Server 2012/ 2012 R2 and Windows Server 2016) on page 2-27
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Modifying the Virtual Machine Environment (Windows XP
and Windows Server 2003)

Procedure

1.  Open a Command Prompt window (cmd. exe) using an account with
administrator privileges.

2.  Perform the following tasks:

TASK STEPS

Set the "Administrator” Type net user "Administrator" 1111.
logon password to "1111".

Configure automatic logon | a. Type the following commands:
from the “Administrator”

account. . REG ADD "HKEY LOCAL_ MACHINE\SOFTWARE

\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultUserName /t
ﬁ Note REG_SZ /d Administrator /£
The logon prompt is
bypassed and the
“Administrator”

REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultPassword /t

account is REG SZ /d 1111 /f

automatically used -

to log on to the + REG ADD "HKEY LOCAL MACHINE\SOFTWARE
system every time \Microsoft\Windows NT\CurrentVersion
the virtual machine \Winlogon" /v AutoAdminLogon /t
starts. REG_SZ /d 1 /f

b. Restart the image.
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TASK STEPS

ﬁ Note

No logon prompt is displayed and the
“Administrator” account is automatically used to
log on.

j’ Administrator

8 Internet .__\) My Documents
Internet Explorer b
. 5 My Recent Documents
( E-mail
Al Microsoft OFfice Outlook,

_f} My Pictures

\’ MSh ___'/ My Music
:3! My Computer
e Windows Media Player

& Contral Panel
,,3 Windows Messenger

@ Set Program Access and
§ Defaults

Microsoft OFfice Excel 2003 .
. |- Printers and Faxes
'® Tour Windows P @) Help and Support
b | Files and Settings Transfer I') Search
Wizard
=) Run...

All Programs D

ﬁ| Log OFF @D | Turn OFf Computer

74 start

FIGURE 2-21. Windows XP Administrator

Account
View all user accounts. Type net user.
Delete non-built-in user Type net user “<username>” /delete.

accounts one at a time.
Example: net user “test” /delete

View all network adapters | Type wmic nic where "netconnectionstatus=2"
with an active link get netconnectionid /value.




OVA File Creation Using New Virtual Machine Images

TASK STEPS

Example output: NetConnctionID=Local Area
Connection

Verify the DHCP status of | Type netsh interface ip show config.

all installed network . . .
The configuration of all installed network adapters

adapters . - .
displays. Verify that the value for DHCP enabled: is
Yes.

Configure a network Type netsh interface ip set address

adapter to use DHCP name="<network adapter>" dhcp.

Example: netsh interface ip set address
name="Local Area Connection" dhcp

Disable Windows Firewall. | Type netsh firewall set opmode mode=DISABLE.

Note

Windows Firewall slows down the installation of
Virtual Analyzer Sensors.

3. Restart the virtual machine.

Modifying the Virtual Machine Environment (Windows
7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2 and Windows Server 2016)

Procedure

1.  Open a Command Prompt window (cmd. exe) using an account with
administrator privileges.

2. Perform the following tasks:
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TASK STEPS

Enable the “Administrator” | Type net user “Administrator” /active:yes.
account.

Set the logon password Type net user "Administrator" 1111.
for the “Administrator”
account to “1111”.

Configure automatic logon | a. Type the following commands:

from the administrator
account + REG ADD "HKEY LOCAL_ MACHINE\SOFTWARE

\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultUserName /t
ﬁ Note REG_SZ /d Administrator /£

Each time the
image starts, the
logon prompt is
bypassed and the
“Administrator”

N REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultPassword /t
REG_Sz /d 1111 /f

account is - REG ADD "HKEY_LOCAL MACHINE\SOFTWARE
automatically used \Microsoft\Windows NT\CurrentVersion
to log on to the \Winlogon" /v AutoAdminLogon /t

system. REG SZ /d 1 /£
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TASK STEPS

ﬁ Note

In Windows Server 2008/2008 R2,
Windows Server 2012/2012 R2 and
Windows Server 2016, launch the
Local Security Policy snap-in
(secpol.msc) to disable the Password
must meet complexity requirements
Local Security Setting.

E) Local Security Polcy = |

FIGURE 2-22. Disable Password
must meet complexity requirements

. Restart the image.
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TASK STEPS

No logon prompt is displayed and the
“Administrator” account is automatically used
to log on.

i 2
—
]I Getting Started »

u Connect to a Projector
%) Remote Desktop Connection

Sticky Notes

6& Snipping Tool

Calculatar

.‘;[ Paint

il XPSViewer

& Windows Faxand Scan
"‘"5’1 RS Default Programs

@ Micrasoft Office Word 2003 Help and Support

¥ All Programs

el
e - ©

FIGURE 2-23. Windows 7 Administrator

Account
View all user accounts. Type net user.
Delete non-built-in user Type net user “<username>” /delete.

accounts one at a time.
Example: net user “test” /delete

View all network adapters | Type wmic nic where "netconnectionstatus=2"
with an active link get netconnectionid /value.

Example output: NetConnctionID=Local Area
Connection

Verify the DHCP status of | Type netsh interface ip show config.
all installed network
adapters
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TASK STEPS

The configuration of all installed network adapters
displays. Verify that the value for DHCP enabled: is

Yes.
Configure a network Type netsh interface ip set address
adapter to use DHCP name="<network adapter>" dhcp.

Example: netsh interface ip set address
name="Local Area Connection" dhcp

Configure AutoPlay a. Open the Windows Start menu, type Control
Panel into the search box and press ENTER.

b. Inthe Control Panel, go to Hardware and Sound
> AutoPlay.

FIGURE 2-24. AutoPlay

c. For Software and games, select Install or run
program from your media.

d. Click Save.

Disable Windows Firewall. | Type netsh advfirewall set allprofiles state
off.

Note

Windows Firewall slows down the installation of
Virtual Analyzer Sensors.
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3.

Restart the virtual machine.

Reducing the Size of VirtualBox Disk Images

Procedure

1.

2.

Uninstall unnecessary applications and optional Windows components.
Run Disk Cleanup to free up space on the hard disk.

The utility searches for files and data that you can safely delete, including:
+  Temporary Windows and Internet files

. ActiveX controls, Java applets, and other downloaded program files
+  TFiles in the Recycle Bin

For details, see the Microsoft Help: http://windows.microsoft.com/en-us

windows/delete-files-using-disk-cleanup#delete-files-using-disk-

cleanup=windows-7.

Use Deployment Image Servicing and Management (DISM) to free up space
on the hard disk.

DISM is a command-line utility that can be used to free up disk space by managing
the Windows Component Store (WinSxS directory).

For details, see the Microsoft Developer resource website: https://
msdn.microsoft.com/en-us/windows/hardware/commercialize/manufacture/

desktop/clean-up-the-winsxs-folder

a.  Open a Command Prompt window.

ﬁ’ Note

Depending on the Windows version, not all of the following commands may be

supported.

b. Typedism /Online /Cleanup-Image /SPSuperseded.



http://windows.microsoft.com/en-us/windows/delete-files-using-disk-cleanup#delete-files-using-disk-cleanup=windows-7
http://windows.microsoft.com/en-us/windows/delete-files-using-disk-cleanup#delete-files-using-disk-cleanup=windows-7
http://windows.microsoft.com/en-us/windows/delete-files-using-disk-cleanup#delete-files-using-disk-cleanup=windows-7
https://msdn.microsoft.com/en-us/windows/hardware/commercialize/manufacture/desktop/clean-up-the-winsxs-folder
https://msdn.microsoft.com/en-us/windows/hardware/commercialize/manufacture/desktop/clean-up-the-winsxs-folder
https://msdn.microsoft.com/en-us/windows/hardware/commercialize/manufacture/desktop/clean-up-the-winsxs-folder
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c. Typedism /Online /Cleanup-Image /StartComponentCleanup /
ResetBase.

4. Download SDelete and then zero out the free space on the hard disk.

SDelete is a free command-line utility that securely deletes existing files and
permanently erases file data in unallocated clusters of a disk. The utility can also
ensures that even encrypted files cannot be recovered by overwriting all
addressable locations with new and random characters.

a.  Download sdelete. zip from the Windows Sysinternals website: https://

technet.microsoft.com/en-us/sysinternals/sdelete.aspx

b. Extract sdelete.exe.
c.  Open a Command Prompt window.
d.  Go to the folder that contains sdelete.exe.
e. Type sdelete -z [drive letter].
SDelete zeroes the free space on the hard disk.
5. Shut down the virtual machine.
6. Open a Command Prompt window on the host system.

7. Type "C:\Program Files\Oracle\VirtualBox\VBoxManage.exe"
modifyhd [path\[vm _name.vdi] --compact.

The virtual hard disk drive size is reduced.

Exporting Virtual Machine Images to OVA Files

A virtual machine image comprises many uncompressed files. The files must be
combined into a single OVA file to avoid issues when importing.



https://technet.microsoft.com/en-us/sysinternals/sdelete.aspx
https://technet.microsoft.com/en-us/sysinternals/sdelete.aspx
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O Important
o

Verify that the size of the created OVA file is supported by your product.

TABLE 2-2. Maximum OVA File Size

PRODUCT

VERSION

MAXxiMUM FILE

SizE
Deep Discovery Inspector 3.8 and earlier 10 GB
3.8 Service Pack 1 | 20 GB
and later
Deep Discovery Analyzer 5.1 and earlier 10 GB
5.5 and later 20 GB
Deep Discovery Email Inspector 2.1 and earlier 10 GB
2.5 and later 20 GB
Trend Micro TippingPoint Advanced 3.8 Service Pack 2 | 20 GB
Threat Protection for Networks and later
Trend Micro TippingPoint Advanced 2.5 and later 20 GB
Threat Protection for Email
Trend Micro TippingPoint Advanced 5.5 and later 20 GB
Threat Protection Analyzer
Deep Discovery Director 1.1 and later 20 GB
Deep Discovery Web Inspector 2.0 and later 20 GB

Procedure

1.

2.

On the VirtualBox Manager screen, power off the virtual machine.

Note

Vertify that the CD/DVD drive is empty before poweting off and exporting.

Go to File > Export Appliance.
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The Export Virtual Appliance window appears.

Export Virtual Appliance

Virtual machines to export

Please select the virtual machines that should be added to the appliance. You can select more than one. Please note that these machines have to be turned
off before they can be exported.

win10_office2016_xBd

Expert Mode Cancel

FIGURE 2-25. Export Virtual Appliance

3. Select the virtual machine image to export and click Next.
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4.

5.

The Storage settings screen appears.

€ Export Virtual Appliance

Appliance settings

Please choose a format to export the virtual appliance to.

The Open Virtualization Format supports only ovf or ova extensions. If you use the ovf extension, several files will be written separately. If you use
the ova extension, all the files will be combined into one Open Yirtualization Format archive,

The Oracle Cloud Infrastructure format supports exporting to remote doud servers only. Main virtual disk of each selected machine will be uploaded to
remote server.

Format: | Open Virtualization Format 1.0 -

Please choose a filename to export the virtual appliance to. Besides that you can specify a certain amount of options which affects the size and content of
resulting archive.

File: |C: Wsersiadministrator \Documents\win 10_office2016_x&4.ova | @

MAC Address Policy: |Indude only NAT network adapter MAC addresses -
Additionally: [] Write Manifest file
[ tndude 150 image files

FIGURE 2-26. Storage settings

Configure the following:
. File: Accept the default name and path or click :L;:-SJ to select a different file.

. Format: Select OVF 1.0.

Important

Format options include OVF 0.9, 1.0 and 2.0. Virtual Analyzer does not
support OVF 2.0.

Click Next.
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The Appliance settings screen appears.

< Export Virtual Appliance

Virtual system settings

This is the descriptive information which will be added to the virtual appliance. You can change it by double dlicking on individual lines.

Wirtual System 1
{3’ MName win10_office2016_x64
@ Product
&) Product-URL
@ Vendor
&) Vendor-URL
@ Version
@ Description

@ License

Restore Defaults Export Cancel

FIGURE 2-27. Appliance settings

6.  Verify that the License field is empty and then click Export.
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VirtualBox creates the OVA file.

Iﬁ Exporting Appliance ...: Export appliance 'ChUsers] Docume...

Exporting to disk image 'win10_office2016_x&64-disk001.vmdk' ... (2/3)

B 8% X

10 minutes remaining

FIGURE 2-28. Disk Image Export Progress Bar




@y Renn

Chapter 3

OVA File Creation Using Converted
Virtual Hard Disk Drives

Learn how to prepare and import an OVA file in the following topics:

Modifying the Virtual Machine Environment on page 3-6

Exporting Virtual Machine Images on page 3-16

Converting V"Mware ESXi Virtual Hard Disk Drives on page 3-23

Creating Virtual Machine Images Using Converted Virtual Hard Disk Drives on page 3-30
Confignring Virtual Machine Images on page 3-46

Exporting Virtual Machine Images to OV'A Files on page 3-51
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Creating OVA Files Using Converted Virtual
Hard Disk Drives

Procedure
1. Prepare Adobe Reader.
For details, see Preparing Adobe Reader on page 3-5
2.  Modify the environment of the virtual machine image.
For details, see Modifying the Virtual Machine Environment on page 3-6.
3. Export the virtual machine image.
For details, see Exporting Virtual Machine Images on page 3-16.
4. Convert the virtual hard disk drive of the exported image to the VirtualBox format.
For details, see Converting V'"Mware ESXi Virtual Hard Disk Drives on page 3-23.
5.  Create a new virtual machine image using the converted virtual hard disk drive.

For details, see Creating V'irtual Machine Images Using Converted 1 irtnal Hard Disk
Drives on page 3-30.

6. Configure the new virtual machine image.
For details, see Configuring Virtual Machine Images on page 3-46.
7.  Export the virtual machine image to an OVA file.

For details, see Exporting Virtual Machine Images to OV A Files on page 3-51.

Required Software

The following software must be installed on the virtual machine to achieve satisfactory

detection results.
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TABLE 3-1. Required Applications

SOFTWARE DESCRIPTION
Operating system Virtual Analyzer supports the following operating systems:
Windows XP
Windows 7

Windows 8/8.1

Windows 10 RS3 and before
+  Windows Server 2003/2003 R2
+  Windows Server 2008/2008 R2
«  Windows Server 2012/2012 R2
+  Windows Server 2016

O Important
<«

«  Package the installer as an ISO file.

«  Activate Windows with a valid product key after the
Virtual Analyzer Image Preparation Tool has validated
and modified virtual machine settings. Do not activate
Windows before that.

«  Use a computer name that reflects your organizations'
naming scheme.

- Disable automatic updates.

+  Trend Micro recommends using the English version of
the listed operating systems.
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SOFTWARE DESCRIPTION

Office suite Virtual Analyzer supports the following office suites:
Office 2003 (32-bit)

Office 2007 (32-bit)

Office 2010 (32-bit and 64-bit)

Office 2013 (32-bit and 64-bit)

Office 2016 (32-bit and 64-bit)

Office 365 (32-bit and 64-bit)

O Important
<«

. Microsoft Word, Microsoft Excel, Microsoft PowerPoint,
and Microsoft Publisher must be installed.

- Activate Microsoft Office with a valid product key after
the Virtual Analyzer Image Preparation Tool has
validated and modified virtual machine settings. Do not
activate Microsoft Office before that.

- After installation, open all Microsoft Office applications
and verify that the main editing screen is displayed. If
any confirmation dialog or welcome screen displays,
make any selection to close the screen and display the
main editing screen.

Welcome to Microsoft Office 2010 =

Help Protect and Improve Microsoft Office ,J&Oﬂ:lE“é

se Recommended Settings

jonal Office 2nd
ms, automaticaly

o Install Updates Only

O Instal impertantand for Office, Windons and Offer me new and
Microsoft software.

° Don't make changes

© Choosing this aption couid expose your computer to security threats.

FIGURE 3-1. Help Protect and Improve Microsoft
Office

Verify that your license allows you to virtualize the
applications. For details, see https://suppo |



https://support.office.com
https://support.office.com/en-us/article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
https://support.office.com/en-us/article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
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SOFTWARE DESCRIPTION

Adobe Reader Install the version of Adobe Reader that is most widely used in
your organization. To download the most current version of Adobe
Reader, go to http://www.adobe.com/downloads/.

If you do not install Adobe Reader, Virtual Analyzer:

Installs Adobe Reader 8, 9, and 11 on all Windows XP and
Windows Server 2003/2003 R2 images during importing.

+ Installs Adobe Reader 9, 11, and DC on all Windows 7 and
newer images during import.

Uses all versions during analysis.

WARNING!

This consumes additional computing resources.

+ Installs .NET Framework 3.5 or later if the operating system
is Windows XP or Windows Server 2003.

Configure Adobe Reader to manually check for and install
updates. For details, see https://helpx.adobe.com/acrobat/kb/
reader-acrobat-updater-settings.html.

O Important
. ®

Do not install VMware tools to avoid triggering the anti-virtual machine functions of some
malware.

Preparing Adobe Reader

Perform the following steps if Adobe Reader is installed on the virtual machine.

Procedure
1. Disable automatic updates.

For details, see http://helpx.adobe.com/acrobat/kb/disable-automaticupdates-

acrobat-reader.html.



http://www.adobe.com/downloads/
https://helpx.adobe.com/acrobat/kb/reader-acrobat-updater-settings.html
https://helpx.adobe.com/acrobat/kb/reader-acrobat-updater-settings.html
http://helpx.adobe.com/acrobat/kb/disable-automaticupdates-acrobat-reader.html
http://helpx.adobe.com/acrobat/kb/disable-automaticupdates-acrobat-reader.html
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2. Install the necessary Adobe Reader language packs so that Virtual Analyzer can
process files authored in languages other than those supported in your native
Adobe Reader.

For example, if you use the English version of Adobe Reader and you expect to
analyze files authored in East Asian languages, install the Asian and Extended
Language Pack.

3.  Start Adobe Reader.

Important

Perform this step before exporting the virtual machine.

Modifying the Virtual Machine Environment

Modify the virtual machine environment to run Virtual Analyzer Sensors, a collection of
utilities that execute and detect malware, and record all behavior in Virtual Analyzer.

«  Modifying the Virtual Machine Environment (Windows XP and Windows Server 2003) on
page 3-6

« Modifying the Virtual Machine Environment (Windows 7/8/8.1/10, Windows Server
2008/ 2008 R2, Windows Server 2012/ 2012 R2 and Windows Server 2016) on page 3-9

. Uninstalling V" Mware Tools on page 3-14

Modifying the Virtual Machine Environment (Windows XP
and Windows Server 2003)

Procedure

1.  Open a Command Prompt window (cmd. exe) using an account with
administrator privileges.

2.  Perform the following tasks:
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TASK STEPS

Set the "Administrator” Type net user "Administrator" 1111.
logon password to "1111".

Configure automatic logon | a. Type the following commands:
from the “Administrator”

account. . REG ADD "HKEY LOCAL_ MACHINE\SOFTWARE

\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultUserName /t
ﬁ Note REG_SZ /d Administrator /£
The logon prompt is
bypassed and the
“Administrator”

o REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultPassword /t

account is REG Sz /d 1111 /f

automatically used -

to log on to the + REG ADD "HKEY LOCAL MACHINE\SOFTWARE
system every time \Microsoft\Windows NT\CurrentVersion
the virtual machine \Winlogon" /v AutoAdminLogon /t
starts. REG Sz /d 1 /£

b. Restart the image.
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TASK STEPS

ﬁ Note

No logon prompt is displayed and the
“Administrator” account is automatically used to
log on.

j’ Administrator

8 Internet .__\) My Documents
Internet Explorer b
. 5 My Recent Documents
( E-mail
Al Microsoft OFfice Outlook,

_f} My Pictures

\’ MSh ___'/ My Music
:3! My Computer
e Windows Media Player

& Contral Panel
,,3 Windows Messenger

@ Set Program Access and
§ Defaults

Microsoft OFfice Excel 2003 .
. |- Printers and Faxes
'® Tour Windows P @) Help and Support
b | Files and Settings Transfer I') Search
Wizard
=) Run...

All Programs D

ﬁ| Log OFF @D | Turn OFf Computer

74 start

FIGURE 3-2. Windows XP Administrator

Account
View all user accounts. Type net user.
Delete non-built-in user Type net user “<username>” /delete.

accounts one at a time.
Example: net user “test” /delete

View all network adapters | Type wmic nic where "netconnectionstatus=2"
with an active link get netconnectionid /value.




OVA File Creation Using Converted Virtual Hard Disk Drives

TASK

STEPS

Example output: NetConnctionID=Local Area
Connection

Verify the DHCP status of
all installed network
adapters

Type netsh interface ip show config.

The configuration of all installed network adapters
displays. Verify that the value for DHCP enabled: is
Yes.

Configure a network
adapter to use DHCP

Type netsh interface ip set address
name="<network adapter>" dhcp.

Example: netsh interface ip set address
name="Local Area Connection" dhcp

Disable Windows Firewall.

Type netsh firewall set opmode mode=DISABLE.

Note

Windows Firewall slows down the installation of
Virtual Analyzer Sensors.

Uninstall VMware Tools.

For details, see Uninstalling VMware Tools on page
3-14.

3. Restart the virtual machine.

Modifying the Virtual Machine Environment (Windows
7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2 and Windows Server 2016)

Procedure

1.  Open a Command Prompt window (cmd. exe) using an account with

administrator privileges.

2.  Perform the following tasks:
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TASK STEPS

Enable the “Administrator” | Type net user “Administrator” /active:yes.
account.

Set the logon password Type net user "Administrator" 1111.
for the “Administrator”
account to “1111”.

Configure automatic logon | a. Type the following commands:

from the administrator
account + REG ADD "HKEY LOCAL_ MACHINE\SOFTWARE

\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultUserName /t
ﬁ Note REG_SZ /d Administrator /£

Each time the
image starts, the
logon prompt is
bypassed and the
“Administrator”

N REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultPassword /t
REG_Sz /d 1111 /f

account is - REG ADD "HKEY_LOCAL MACHINE\SOFTWARE
automatically used \Microsoft\Windows NT\CurrentVersion
to log on to the \Winlogon" /v AutoAdminLogon /t

system. REG SZ /d 1 /£




OVA File Creation Using Converted Virtual Hard Disk Drives

TASK STEPS

ﬁ Note

In Windows Server 2008/2008 R2,
Windows Server 2012/2012 R2 and
Windows Server 2016, launch the
Local Security Policy snap-in
(secpol.msc) to disable the Password
must meet complexity requirements
Local Security Setting.

E) Local Security Polcy = |

FIGURE 3-3. Disable Password must
meet complexity requirements

. Restart the image.
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TASK STEPS

No logon prompt is displayed and the
“Administrator” account is automatically used
to log on.

i 2
—
]I Getting Started »

u Connect to a Projector
%) Remote Desktop Connection

Sticky Notes

6& Snipping Tool

Calculatar

.‘;[ Paint

il XPSViewer

& Windows Faxand Scan
"‘"5’1 RS Default Programs

@ Micrasoft Office Word 2003 Help and Support

¥ All Programs

el
e - ©

FIGURE 3-4. Windows 7 Administrator

Account
View all user accounts. Type net user.
Delete non-built-in user Type net user “<username>” /delete.

accounts one at a time.
Example: net user “test” /delete

View all network adapters | Type wmic nic where "netconnectionstatus=2"
with an active link get netconnectionid /value.

Example output: NetConnctionID=Local Area
Connection

Verify the DHCP status of | Type netsh interface ip show config.
all installed network
adapters
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TASK STEPS

The configuration of all installed network adapters
displays. Verify that the value for DHCP enabled: is

Yes.
Configure a network Type netsh interface ip set address
adapter to use DHCP name="<network adapter>" dhcp.

Example: netsh interface ip set address
name="Local Area Connection" dhcp

Configure AutoPlay a. Open the Windows Start menu, type Control
Panel into the search box and press ENTER.

b. Inthe Control Panel, go to Hardware and Sound
> AutoPlay.

FIGURE 3-5. AutoPlay

c. For Software and games, select Install or run
program from your media.

d. Click Save.

Disable Windows Firewall. | Type netsh advfirewall set allprofiles state
off.

Note

Windows Firewall slows down the installation of
Virtual Analyzer Sensors.
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TASK STEPS

Uninstall VMware Tools. For details, see Uninstalling VMware Tools on page
3-14.

3. Restart the virtual machine.

Uninstalling VMware Tools

VMware Tools will attempt to connect to a VMware ESXi host, which might prevent
VirtualBox from importing the virtual machine image.

Procedure
1.  Go to Start > Control Panel.

The Control Panel screen appears.
2.  Check the list of installed programs.

+  Windows XP and Windows Server 2003: Click Add or Remove Programs.

. Windows 7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2 and Windows Setver 2016: Click Programs and Features.
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A list of installed programs appears.

® Add or Remove Programs E| @WZ'

—
Eﬁ-_‘f Currently installed programs: O show updakes Sort by: | Mame v
Mﬁ & | 15 Micrascft NET Framewerk 2.0 Service Pack 1 Size  185.00MB
Prografns §5) Microsoft .NET Framework 3.0 Service Pack 1 Size  245.00M8
% §8) Microscit JNET Framework 3.5 Size  Z5.02MB
ndd'uew C13 Microsoft Office Enterprise 2007 Size  BOB.00MB
Programs £13 Microsoft Office Professional Edtion 2003 Size  349.00MB
g §5) Microsoft isual C-4 2008 Redistributable - x86 9.0.30729.4148 Size  10.19M8
m ¥iware Tools
A [Remove
Windows oL
Components
To change this progranm of remoye it from y COMpLULEr, Change or Remove.
@’ 8 Windowes Irernet Explorer 8 Size 4.36MB
Set Program
Access and
Def aults

FIGURE 3-6. Add or Remove Programs (Windows XP)
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[E=SEch ===
@uvlr; ¢ Ceontrel Panel » Programs » Programs and Features v | ¥y [ search ograms and Features F=)
Conitrol Panel Home . I
Uninstall or change a program
View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.
B Turn Windews features on or
Gl Organize v Uninstall = > B
Name : Publisher Inztalled On
[077-Zip 4.65 9/16/2014
I Microsoft NET Framework 4 Client Profile Microsoft Corporation 971772014
--3__!-hli<r-:sol1 JNET Framewerk 4 Extended Micresoft Corporation 8/17/2014
03 Micresoft Office Enterprise 2007 Microsoft Corporation 972014
O3 Microsoft Office Professional Edition 2003 Microsoft Corporation 8/17/2014

ficresoft Visual C+ + 2008 Redistributable - 86 9.0.3... Microsoft Corporation
WJMwue Tools Viviware, Inc.

t version: 8.6.5.11214
Help link: hitpy/fwwwy

FIGURE 3-7. Add or Remove Programs (Windows 7)

3. Select VMware Tools and then click Remove (Windows XP or Windows Server
2003) or Uninstall (Windows 7/8/8.1/10, Windows Server 2008/2008 R2,
Windows Server 2012/2012 R2 or Windows Setver 2016).

4. Click Yes to uninstall VMwatre Tools.

5. Click Yes to restart Windows.

VMware Tools is uninstalled.

Exporting Virtual Machine Images

You must verify and modify some settings before exporting a virtual machine image
from VMware ESXi or Workstation.

. Verifying Virtual Machine Settings on V' Mware Workstation on page 3-17

«  Exporting Virtnal Machine Images on V- Mware ESXi on page 3-19
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. Converting V"Mware ESXi Virtual Hard Disk Drives on page 3-23

Verifying Virtual Machine Settings on VMware Workstation

Procedure
1. Shut down the virtual machine.
2. In the left pane, right-click the virtual machine and then select Settings.

The Virtual Machine Settings screen appeats.

Virtual Machine Setti

[ Processors: 1 | Connect at power on

et Hard Disk (IDE) 15G8

) CLyOVD (IDE) Autp detect Connection

= Floppy Auto detect .

Tl Metwork Adapter  MAT B9 LsA phwsce e

S useController  Present | Auto detect -
) Sound Card Auto detect X "

2 Prieed Brasirt Use IS0 image file:

& Display Auto detect - Browse...

FIGURE 3-8. Virtual Machine Settings
3.  On the Hardware tab, verify the following:
+  CD/DVD (IDE): Connection is Use physical drive.

+  Floppy: Connection is Use physical drive.
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Virtual Machine Setti

= Memory 512 MB Connected
[ Processors 1 + | Connect at power on
CiHard Disk (IDE)  15GB
, COYIVD (IDE) Auto detect Connection
ClFopoy  Auodetea | physical arhe:
Fig Metwork Adapter  NAT bl (53
SusBController  Present [ Auto detect -
&)’ Sound Card Auto detect
) Prinker Use floppy image file
& Display Auto detect
Create... Browse...
Read-only

FIGURE 3-9. Virtual Machine Settings - Hardware

4.  Go to the Options tab and then click General.

5. In the right pane, under Working directory, locate the Virtual Machine Disk
(* . vmdk).
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Limoe

Solaris
VMware ESX
Other
Version:
| Windows XP Professional

Working directory

C:\Users\Administrator\C \Virtual Mact

1/ Suspend and snapshat files will be stored here,

Enhanced virtual keyboard
o
4\ The VMware keyboard driver is not installed on the host.

FIGURE 3-10. Working Directory

Exporting Virtual Machine Images on VMware ESXi

Procedure
1.  Shut down the virtual machine.

2. In the left pane, right-click the virtual machine and then select Edit Settings.
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(622200 v e . =~

File Edit View Inwventory Administration Plug-ins Help

G & f Home * & Inventory @ Inventory

"l eBEGHRn oD P

B 0 17222130 Bl i : = :

::j ESXI_ win7splen offic noab ESKi xDsn-_‘e.n offices_noab
Power v

Performance

-
Guest il ]
__ Snapshot re computer that, like @ Virtual Machines
@ OpenConsole loperating system and
E Sett fystem installed on a virtual
i Edit ings... perating system
Upgrade Virtual Hardware
— ine 5 an isolated computing -
Add Permission... Ctr+P  hrtual machines as deskiop or =
Report Performance 5 testing environments, or to g
- bns
Rename ts. The same host can run -
Openin New Window... CtrisAlt+N -
Remaove from Inventory kl

Delete from Disk

BATIC TSRS

| Power on the virtual machine

(» Edit virtual machine settings

Tasks root
L J

FIGURE 3-11. Edit Settings

The Virtual Machine Properties screen appears.
3. On the Hardware tab, verify the following settings:

. CD/DVD drive 1: Client Device

+  Floppy drive 1: Client Device
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~ - Virtual Machine Properties

Hardware | Ootions | Resources |

[ Show Al Devices ad.. | Remove |
Hardware Summary

o8 Memory 512 MB

@A orus 1

B video card Video card

= VMO device Restricted

= Hard disk 1 Wirtual Disk

5 C0/OVD drive 1 Client Device

B Metwork adapter 1 WM Metwork

& Floppy drive 1 Client Device

FIGURE 3-12. Virtual Machine Properties - Hardware

4. In the left pane, select the virtual machine and then go to File > Export > Export
OVF Template.
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()172.22.130 _vSphere

File | Edit View Irnventory Administration Plug-ins Help
»
o) v Inventory
Deploy OVF Template...
Export L3 Export OVF Template...
Report L Export List..
Browse VA Marketplace... Export Maps... roe Allocation | Performance | Events . Console . Permissions
Print Maps : Export System Logs...
N ‘What is a Virtual Machine?
Exit
A virtual maching is a soffware computer that, ke a Varbasl Machines
physical computer, runs an operating system and e
applications. An operating system instalied on a virtual s
machine is called a guest operating system .
Because every virtual maching s an isolated computing '(J\
environment, you can use virtual machines as desktop or =
workstation environments, as testing environments, or 10 =
consolidate server applications.
Virtual machines run on hosts. The same host can run
many virtual machines. ;.K|
Basic Tasks
¢ Power on the virtual machine
G Edit virtual machine settings
-
Tasks root
2 4

FIGURE 3-13. OVF Template

The Export OVF Template screen appeats.
5.  Configure the following settings:

+  Name: Type a name for the virtual machine image.

ﬁ Note

(Optional) Click the folder icon to change the path of the OVF template files.

+  Format: Select Folder of files (OVF).

Important

Verify that Include image files attached to floppy and CD/DVD devices in the
OVF package is not selected.

6. Click OK.
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Converting VMware ESXi Virtual Hard Disk Drives

VirtualBox does not support the virtual hard disk drive format (* . vindk) of VMware
ESXi images. Use one of the following tools to convert the disks:

. Using V" Mware vCenter Converter Standalone on page 3-23
. Using QEMU on page 3-29

Using VMware vCenter Converter Standalone

Procedure

1.  Download VMware vCenter Converter Standalone from https://

my.vmware.com/web/vmware/info/slug

infrastructure_operations_management/vmware_vcenter_converter standalone/
5_5#product_downloads.

ﬁ Note

VMware vCenter Converter Standalone 5.0 does not support vCenter Server and
ESXi versions later than 5.0. Download and install a version later than 5.0.1.

2. Open VMware vCenter Converter Standalone and then click Convert machine.



https://my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/vmware_vcenter_converter_standalone/5_5#product_downloads
https://my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/vmware_vcenter_converter_standalone/5_5#product_downloads
https://my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/vmware_vcenter_converter_standalone/5_5#product_downloads
https://my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/vmware_vcenter_converter_standalone/5_5#product_downloads
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le View Task Administration Help
% Convert machine & Configure machine O

View by: ~ Tasks Show: = Running tasksin ~ Recenttasks
TaskID JobID Source Destination Status Start time End time

Welcome to VMware vCenter Converter Standalone
VMware vCenter Comverter Standalone allows you to take one of a variety of machines and cornvert
it into a new VMware virtual machine. The machines you may corvert include:

Convert . ppysical machines
Maching  _ymware virtual machines (vm)
-VMware Consolidated Backup (.vmx)
- Microsoft VirtualPC's or Virtual Server virtual machines (vmc)
- Symantec LiveState Recovery Image (.sv2i)
- Acronis True Image Backup (.tib)
- StorageCraft ShadowsStor (spf)
- Parallels Virtualization Products (.pvs)
- Hyper¥ virtual machines

FIGURE 3-14. VMware vCenter Converter Standalone

The Conversion window opens.

On the Source System screen, configure the following:

a.  Select source type: Select VMware Infrastructure virtual machine.
b.  Server: Type the ESXi server IP address.

c.  User name, Password: Type the credentials that provide administrator
access to the VMware server.

Click Next.
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5.

The Source Machine screen appears.

Source Machine
Select the virtual machine you want to convert
Source System Source: & 172.22.1.30 Destination: none
Source Machine
Destination System  Inventory for: 172.22.1.30 Search for name with: Clear
Options I =
Summary ‘fM narne_ i Power state
& ESXi_win7splen_offices_noab Powered off
|5 ESXi_xpsp3en_offices_noab | Powered off
Refresh View source details...
‘ 1 13
; Help Export diagnostic logs... IL <Back J' Cancel

FIGURE 3-15. Conversion > Source Machine

Select the virtual machine that you want to convert and then click Next.
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The Destination System section appears.

Destination System
Select a host for the new virtual machine

Source System Source: @& ESXi_xpsp3en_offices_noab on 172.22.1.30 Destination: none

Source Machine . _
Destination Syste Select destination type: \U'Mware Workstation or other VMware virtual machine x|

Options Creates a new virtual machine for use on YMware Workstation, Viware
Summary Player, VMware Fusion or other VMware product.

Select VMware product: VMware Workstation 6.5 -

Virtual machine details

Name: ESXi_xpsp3en_offices_noab

Select a location for the virtual machine: ) )
¥:\for_USBox3.61\for_virtualbox\ESXi ~ Browse...

‘ 1l [

; Help Export diagnostic logs... | <Back Cancel

FIGURE 3-16. Conversion > Destination System
6. Configure the following and then click Next.

a.  Select destination type: Select VMware Workstation or other VMware
virtual machine.

b. Select VMware product: Select VMware Workstation 6.5.x.

c.  Virtual machine details: Accept the default name and location or click
Browse to select a different file.
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The Options screen appears.

Options
Set up the parameters for the conversion task

Source: & ESXi_xpsp3en_offic--- Destination: % Y:\for_U---\ESXi (VMware Workstation 6.0.x)
Click on an option below to edit it.

Current settings: ]
Options - Data to copy Edit
Summary Copy type: Disk-based
VirtualDisk1: 15 GB
= Devices Edit

vCPUs: 1 (1 sockets * 1 cores)
Disk controller: Auto select

Memory: 512MB

= Networks Edit
NIC1: Bridged

~ Services Edit
Total: 93 service(s)

- M Advanced options Edit

Install VMware Tools: No
Ay Customize Guest O5: NfA
Remove Restore Checkpoints: Yes
Reconfigure: Yes
=Throttling Edit
CPU: None
Network bandwidth: None

‘ 1l 3

Wl [ Help | Export diagnostic logs... [_<Backjj Next > ] [ Canceld'

FIGURE 3-17. Conversion > Options

7.  Verify the settings and then click Next.

Important

Verify that Install VMware Tools is set to No.

The Summary screen appears.
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Summary
Review the conversion parameters
Source: & ESXi_xpsp3en_offic--- Destination: & Y:\for_U---\ESXi (VMware Workstation 6.0.x)
Destination System Source system information
Options Source type: VMware Infrastructure virtual machine
Summary Source VM: ESXi_»psp3en_offices_noab
Host/'Server: 172.22.1.30
Connected as: root
CPU throttiing: MNone =
Metwork throtting: Mone
Destination system information
Virtual machine name: ESXi_xpspden_offices_noab_convert v
Destination product Wiviware Workstation 6.0.x
Destination directory: Yi\for_USBod.61\or_virtualboX\ESXi
Number of vCPUs: 1 (1 sockets * 1 cores)
Physical memory: s512mB
Network: Preserve NIC count
MNIC1 Connected
Bridged connection
Disk controller type: Auto select i
Storana: . Nigk-hazad clonina
5 = R o« Hi »
Help | Export diagnostic logs... [ < Back | Finish Cancel

FIGURE 3-18. Conversion > Summary

8.  Verify the information and then click Finish.
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VMware vCenter Converter Standalone converts the Virtual Machine Disk (* . vindk).

5] vMware vCenter Converter Standalo - "

File View Task Administration Help
% Corvert machine & Configure machine O

Viewby: = Tasks Show: ~ All tasksin ~ Recent tasks

TaskiD  JobID  Source Destination Status Starttime  End time
®3 El 172221 30/E500_xpsp3en_++ \ESXi_xpsp3en offices n- [ ] 2%  2014M12/5+ Estimated time remaining: 1 hours--+

Welcome to VMware vCenter Converter Standalone

WMware vCenter Converter Standalone allows you to take one of a variety of machines and comvert
it into a new VMware virtual machine, The machines you may corvert include:

Corvert . physical machines
Machine  _ynMware virtual machines (vmx)
-VMware Consolidated Backup (vmx)
- Microsoft VirtualPC's or Virtual Server virtual machines (vmc)
- Symantec LiveState Recovery Image (.sv2i)
- Acronis True Image Backup (.tib)
- StorageCraft ShadowStor (spf)
- Parallels Virtualization Products (.pvs)
- Hyper- virtual machines

FIGURE 3-19. Image Conversion Progress

Using QEMU

For details on QEMU, see http://wiki.qemu.org/Main_Page.

Procedure

1. Download the latest version of QEMU from http://qemu.weilnetz.de/w64/.

2. Install QEMU with the default settings.

3.  Open a Command Prompt window (cmd. exe) using an account with
administrator privileges.

4.  Convert the Virtual Machine Disk (* . vmdk) by typing the following command:

gemu-img.exe convert [-f fmt] [-O output fmt] filename
output filename.



http://wiki.qemu.org/Main_Page
http://qemu.weilnetz.de/w64/
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For example:

"C:\Program Files\gemu\gemu-img.exe" convert -f vmdk -O vmdk
C:\ESX_xpsp3en_offices noab.vmdk C:\ESX xpsp3en_offices noab_converted.vmdk

The * . vmdk file can be used to create an OVA file using VirtualBox.

Creating Virtual Machine Images Using Converted Virtual
Hard Disk Drives

Use VirtualBox to create a new virtual machine image.
« Downloading and Installing V irtualBox on page 2-5

« Creating Virtual Machine Images Using VirtnalBox on page 3-31

Downloading and Installing VirtualBox

Procedure

1. Download the latest version of VirtualBox from https://www.virtualbox.org

wiki/Downloads.

ﬁ Note
The VirtualBox Open Source Edition is licensed under the GPL V2. The full text of
the license is available at http://www.gnu.org/licenses/old-licenses/gpl-2.0.html.

2.  Configure the language settings using one of the following methods:

+  Install VirtualBox with English as the default language.

. After installation, go to File > Preferences > Language and then select
English.



https://www.virtualbox.org/wiki/Downloads
https://www.virtualbox.org/wiki/Downloads
http://www.gnu.org/licenses/old-licenses/gpl-2.0.html
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{fi’ VirtualBox - Preferences ? ot
E General Language
@ Input Interface Languages
Default ~
@ Update English (built-in)
@ Bahasa Indonesia
Language Catals
@ Displ Cettina
Ispay Danzk
Iﬁ Metwork Deutich {Deutschland)
Esparicl
D Extensions Fuskara ~
Language: English (built-in)
Eﬁ Proxy Author(z): Orade Corporation

Cancel

FIGURE 3-20. Language Settings

Creating Virtual Machine Images Using VirtualBox

Procedure

1.  Open VirtualBox.
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The VirtualBox Manager window opens.

¥ Oracle UM VirtualBox Manager - m} X

¢ AR Gap

Preferences  Import Export New Add

File Machine Help

‘Welcome to VirtualBox!

The left part of application window contains global tools and
lists all virtual machines and virtual machine groups on your
computer. You can import, add and create new YMs using
corresponding toolbar buttons. You can popup a tools of
currently selected element using corresponding element
button.

You can press the FL key to getinstant help, or visit
www.virtualbox.org for more information and latest news.

FIGURE 3-21. VirtualBox Manager

2. Click New.
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The Create Virtual Machine window opens.

Create Virtual Machine

Name and operating system

Please choose a descriptive name and destination folder for the new virtual
machine and select the type of operating system you intend to install on it.
The name you choose will be used throughout VirtualBox to identify this

machine.
Mame: || |
Machine Folder: | D:WirtualBox YMs hd |
.= : Evg
Type: |Microsoft Windows i
Wi
Version: | Windows 10 (54-bit) 7

Expert Mode Mext Cancel

FIGURE 3-22. Create Virtual Machine

3. On the Name and operating system screen, configure the following:
+  Name: Type a permanent name for the virtual machine.
«  Type: Select Microsoft Windows.

. Version: Select Windows XP, Windows 2003, Windows 7, Windows 8,
Windows 8.1, Windows 10, Windows 2008 /2008 R2, Windows 2012/2012
R2 or Windows 2016.

4. Click Next.
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The Memory size screen appears.

Create Virtual Machine

Memory size

Select the amount of memory (RAM) in megabytes to be allocated to the
wirtual machine.

The recommended memory size is 2048 MEB,

0 24 [ e

4 MB 32768 MB

FIGURE 3-23. Memory Size
5. Specify the recommended memory size for your operating system.
+  Windows XP and Windows Server 2003: 512 MB

. Windows 7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2 and Windows Server 2016: 1024 MB

6. Click Next.
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The Hard disk screen appears.

Create Virtual Machine

Hard disk

If you wish you can add a virtual hard disk to the new machine, You can
either create a new hard disk file or select one from the list or from another

|ocation using the folder icon.

If you need a more complex storage set-up you can skip this step and make
the changes to the machine settings once the machine is created.

The recommended size of the hard disk is 50,00 GB.

(® Do not add a virtual hard disk
() Create a virtual hard disk now
() Use an existing virtual hard disk file

Empty

FIGURE 3-24. Hard Disk

7. Select Do not add a virtual hard disk and then click Create.
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The following message appears:

¥ VirtualBox - Warning ? >

You are about to create a new

4 wvirtual machine without a hard disk.
¥ou will not be able to install an
operating system an the machine
until you add one, In the mean time
you will only be able to start the
machine using a virtual optical disk
or from the network,

FIGURE 3-25. Warning

8. Click Continue.
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VirtualBox creates the virtual machine. The new virtual machine appears in the left
pane.

W% Oracle UM VirtualBox Manager - o X

File  Machine Help

{} {3} V E&v (23 Detais . (@) Snapshots

New Settngs Dscard  Start

5| General = preview

Name: win10_office2016_x64
Operating System:  Windows 10 (64-bit)

& svstem ©
Base Memory: 1026

B
BootOrder:  Fioppy, Optical, Hard Disk
Acceleration:  VT-x/AMD-V, Nested Paging, Hyper-V Paravirtuaization

win10_office2016_x64

Display
Video Memory:
Remote Deskiop Server: Disabled
Video Capture: Disabled

storage

Controller: SATA
SATAPortD:  [Optical Drive] Empty

B Audio

HostDriver: Windows DrectSound
Controller:  Intel HD Audio

& Network
Adspter 1: _Intel PROJ1000 T Deskiop (NAT)

5 uss

USB Controler:  OHCT
Device Fiters: 0 (0 active)

[ shared folders
None
© Description

None

FIGURE 3-26. Newly-created Virtual Machine

9. Click Settings.
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The Settings window opens.

General
System
Display
Storage
Audio
Metwork
Serial Ports
UsSB

Shared Folders

A02PPaTENEF N

User Interface

) win10_office2016_x64 - Settings

General

Basic Advanced Description Disk Encryption

Mame: |wini0_office2016_x64

Type:  Microsoft Windows

Version: | Windows 10 (64-bit)

Cancel

FIGURE 3-27. VirtualBox Settings

10. In the left pane, click System.
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The System screen appears.

) win10_office2016_x64 - Settings ? X
E General System
@ System Motherboard  Processor  Acceleration
B Display Base Memory: ' 1024MB |+
4ME 32768 MB
Storage
L]
. Boot Order: Floppy
(‘DII Audio ® Optical
Hard Disk
@ Metwork O @ Network
@ Serial Ports Chipset: | ICH9 hd
ﬁ USE Pointing Device: | USE Tablet A
Ij Extended Features: Enable 1/ APIC
Shared Fold
ared rolders [ Enable EFI (special OSes only)
EI User Interface [ Hardware Clock in UTC Time

Cancel

FIGURE 3-28. System Screen
11.  On the Motherboard tab, configure the following:
«  Chipset: Select ICH9.
«  Pointing Device: Select USB Tablet.
. Extended Features: Select Enable 1/0O APIC.

12. Go to the Processor tab and then select Enable PAE /NX.

13. Go to the Acceleration tab and then select Enable VT-x/AMD-V and Enable
Nested Paging.
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ﬁ Note

The Acceleration tab is only available if the processor of the host system supports
virtualization technology and the virtualization setting is enabled in the BIOS of the
host system.

14. In the left pane, click Storage.

The Storage screen appears.

3 win10_office2016_x64 - Settings ? X
E General Storage

IEI System Storage Devices Attributes

|E| Display & Controller: SATA @@ Name: |SATA |

@ Empty Type: |AHCI =

SerezE Port Count: |2 s |
(‘D:l Audio [ use Host IO Cache

@ Metwork

@ Serial Ports

ﬁ USE

D Shared Folders

EI User Interface

@

Cance

FIGURE 3-29. Storage Screen

15. (Optional) If Controller: SATA appears under Storage Tree, remove the SATA
controller and then add the virtual hard drive to the IDE controller.

a.  Click Controller: SATA and then click € to remove the default controller.

b.  Click Controller: IDE and then click [gh.
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The following message appears:

23 VirtualBox - Question ? >

You are about to add a virtual hard disk to
controller IDE.

Would you like to create a new, empty file to
hold the disk contents or select an existing one?

Create new disk  |Choose existing diskl Cancel

FIGURE 3-30. Choose Existing Disk
c.  Click Choose existing disk and then select the converted * . vmdk file.
d.  Under Attributes, retain all default settings.

e.  Under Storage Tree, click Controller: IDE and then click the empty optical
drive icon.

f.  Under Attributes, verify that CD/DVD Drive is IDE Secondary Master.
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€23 win10_office2016_x64 - Settings ? ®
E General Storage
IE‘ System Storage Devices Attributes
|E| Disal @ Controller: IDE Optical Drive: | IDE Secondary Master hd @l
Isplay
2] win10_office2016_x&4.vmdk [ Live co/ovD

Storage @ Empty Information

Type: —
(D] Audio b

Size: —
@ Network Location: —

Attached to: —

@ Serial Ports
ﬁ? USB
Ij Shared Folders
EI User Interface

@@=

Cnc

FIGURE 3-31. IDE Secondary Master

16. (Optional) In the left pane, click Audio and verify that Enable Audio is enabled.
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23 win10_office2016_x64 - Settings ? X
E General Audio

E‘ System Enable Audio

|§| . Host Audio Driver: | Windows DirectSound A

Display
Audio Controller: | Intel HD Audio A
Storage
Extended Features: Enable Audio Output

(D:I Audio [ Enable Audio Input

@ Metwork

@ Serial Ports

ﬁ USB

D Shared Folders

EI User Interface

Cancel

FIGURE 3-32. Audio Options Settings
17. In the left pane, click USB and then select Enable USB Controller.

Q Important
oy . .
Verify that USB 1.1 (OHCI) Controller is selected.
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23 win10_office2016_x64 - Settings ? X
E General uUsB
E‘ System Enable USE Controller
) (@ USB 1.1 (OHCI) Controller
|§| Display
(C) USB 2.0 (EHCI) Controller
Storage (0) USB 3.0 (xHCI) Controller
. ice Filters
(D:I Audio USE Device Fi
@ Metwork @
@ Serial Ports
ﬁ Use
D Shared Folders
EI User Interface
Cancel

FIGURE 3-33. Enable USB Controller

18. In the left pane, click Shared Folders and then verify that no folders ate shared.
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19.

20.

E General

System
Display
Storage
Audio
Metwork
Serial Ports
USE

Shared Folders

B GETENE

User Interface

23 win10_office2016_x64 - Settings

Shared Folders

Shared Folders

Mame Path
Machine Folders

Access Auto Mount At [a

Cancel

FIGURE 3-34. Shared Folders Settings

Click OK.

The Settings window closes.

On the VirtualBox Manager screen, click ;} to power on the image.
art
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¥ Oracle UM VirtualBox Manager - m} x

File Machine Help

B e Q3 e
New Settings Discard | Start

T =] General =) preview

0 @ Powered Off Mame: win10_office2016_x64
Operating System:  Windows 10 (54-b1t)
Settings File Location: ~ D:\Virtualbax ¥Ms
\Win10_office2015_x64

[ system win10_office2016_x64

Base Memory: 1024 MB

Boot Order:  Floppy, Optical, Hard Disk

Chipset Type:  ICH

Acceleration:  VT-x/AMD-V, Nested Paging, PAE/NX,
Hyper-¥ Paravirtuaization

[®) pisplay

video Memary: 128 MB
Graphics Controller: VBoxSVGA
Remote Desktop Server:  Disabled
Recording: Disabled

Storage
Controller: IDE

IDE Primary Master: win10_office2016_x64.vmdk (Normal, 25.00 GE)
IDE Secondary Master:  [Optical Drive] Empty
fp Audio

HostDriver:  Windows Directsound
Controller:  Intel HD Audio

EP Network
Adapter 1:  Intel PRO/1000 MT Desktop (NAT)

[ usB

USB Controller:  OHCI
Device Filters: 0 (0 active)

[ Shared folders
Mone
&) Description

None

FIGURE 3-35. VirtualBox Manager

21. Install Microsoft Office and other software to achieve satisfactory detection results.

Configuring Virtual Machine Images

Configure virtual machine images that were created using converted virtual hard disk
drives to avoid importing issues.

« Configuring Virtual Machine Images (Windows XP and Windows Server 2003) on page 3-47

« Configuring Virtnal Machine Images (Windows 7/8/8.1/ 10, Windows Server 2008 /2008
R2, Windows Server 2012/ 2012 R2 and Windows Server 2016) on page 3-50
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Configuring Virtual Machine Images (Windows XP and
Windows Server 2003)

Procedure

1.

2.

On the guest operating system, click Start, right-click My Computer, and then
click Manage.

The Computer Management screen appears.

=] Computer Management E‘ @wg

=) Fie  Action  View ‘Window Help NETET
m R R

L} Computer Management (Local) Hame
= iy System Tools ESy‘ﬂm Tools
& | L] Event Viewer S storage

] Shared Folders i
Ser and Applications

+ Local Lisers and Groups & s

F

Performance Logs and Alert:
B Device Manager

# i Removable Storage
Dk, Defragmenter
Dk Management
# (1 Services and Applcations

FIGURE 3-36. Computer Management

In the left pane, click Device Manager.
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A list of devices appeats.

= Computer Management

=) Fle Action View Window Help

# ) Shared Folders
xﬁwduwsw&m

Performance Logs and Alert:

=1 x|
« = W& Pm A
:-Atummmauqﬁmﬂ.ocaﬂ =
= § System Tools + 4 Eatteries
# (L] Everit Viewer ¥ 1§ Comguter
) e Dih drives

# @ Display adapters
4Lk DVDCD-ROM drives

2B} Devvice Manager + {5 Human Interface Devices
= & Storage + (=) IDE ATAATARL controbers
* Removable Storage o

Disk Defragementer #1-T7) Mice and cther pointing devices

Disk Management = HE Metwork adapbers
# [l Services and Applcations BB AMD PCNET Famiy PCI Ethernet Adapher #2

= G Other devices
3 Base System Device

1 Wideo Controller (VGA Compatible)
4 Ports (COM & LPT)
4 & Processors
+ @, Sound, video and game controllers
+ &g Sysbem devices
¥ Universal Serial Bus controllers

FIGURE 3-37. Device Management - Network Adapter Window

3. In the right pane, click Network adapters and then verify that the network
adapter driver is ready.

4.  Open a Command Prompt window (cmd. exe) using an account with
administrator privileges.

5. Disable the Found New Hardware Wizard by typing the following commands:
+  Windows XP 32-bit:

reg add "HKEY LOCAL MACHINE\Software\Policies\Microsoft
\Windows\DeviceInstall\Settings" /v SuppressNewHWUI /t
REG DWORD /d 1 /f

. Windows XP 64-bit or Windows Server 2003:
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reg add "HKEYiLOCALiMACHINE\SYSTEM\CurrentCOntrolSet
\Services\PlugPlay\Parameters" /v SuppressUI /t
REG_DWORD /d 1 /f

Found Hew Hardware Wizard

Welcome to the Found New
Hardware Wizard
Windowrs vwill seanch for curent and updated softveaes by

Icoking on your computed, on the hasdeare instalation CD., o on
the Windows Update Wb site [with powr permission]

Fead ow pevacy pobcy

Can \Windows connect 1o Windows Updabe to search fior
sofbsare?

() ¥es. this time only
() ez, now and gveny time | cornect a device
(2 Mo not thes bme

Chek Nesd ba conlinue.

FIGURE 3-38. Found New Hardware Wizard

6. Restart the image and then verify that the Found New Hardware Wizard does
not appear.

7. Power off the image.
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Configuring Virtual Machine Images (Windows 7/8/8.1/10,
Windows Server 2008/2008 R2, Windows Server 2012/2012
R2 and Windows Server 2016)

Procedure

1.

On the guest operating system, click Start, right-click Computer, and then click

Manage.

The Computer Management screen appears.

A Computer Management
File Action View Help

= |0 = HE

ilﬁf Cemputer Management (Local | Name
| a [} System Teels
(®) Task Scheduler
8] Event Viewer
il Shared Folders
:b_' Lecal Users and Groups
(S Perfermance

I} System Tools
&8 Storage

Do Services and Applications

= Device Manager
4 2 Storage
= Digk Management
:_', Services and Applications

Actions

Computer Management (L., =

Mere Actions

FIGURE 3-39. Computer Management

In the left pane, click Device Manager.
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A list of devices appeats.

A Computer Management

File Action View Help

e 2@ EE &
_'&- Cemputer Management (Local
a ff} System Tocls
(D) Tesk Scheduler
[ Event Viewer
] Shared Folders
& Local Users and Groups
() Performance
= Device Menager
4 B3 Storage
= Disk Management
> _'=g Services and Applications

o lE-|wE]
# = tmuskx-PC Actions
&
]é_ Batteries Device Manager s
{E Computer
Mere Actions b

Ca Disk drives
B Display adapters
oy DVD/CD-ROM drives
3‘_;] Human Interface Devices
g IDE ATA/ATAR controllers
= Keyboards
,ij Mice and other pointing devices
I Menitors
4 ¥ Metwork sdapters
&¥ Intel(R) PRO/1000 MT Desktop Adapter
4 -5 Other devices
U5 Base System Device
Y¥ Ports (COM & LPT)
n Processors
(E System devices
W Universal Sermal Bus controllers

FIGURE 3-40. Device Management - Network Adapter

3. In the right pane, click Network adapters and then verify that the network

adapter driver is ready.

4.  Power off the image.

Exporting Virtual Machine Images to OVA Files

A virtual machine image comprises many uncompressed files. The files must be
combined into a single OVA file to avoid issues when importing.
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O Important
o

Verify that the size of the created OVA file is supported by your product.

TABLE 3-2. Maximum OVA File Size

PRODUCT

VERSION

MAXxiMUM FILE

SizE
Deep Discovery Inspector 3.8 and earlier 10 GB
3.8 Service Pack 1 | 20 GB
and later
Deep Discovery Analyzer 5.1 and earlier 10 GB
5.5 and later 20 GB
Deep Discovery Email Inspector 2.1 and earlier 10 GB
2.5 and later 20 GB
Trend Micro TippingPoint Advanced 3.8 Service Pack 2 | 20 GB
Threat Protection for Networks and later
Trend Micro TippingPoint Advanced 2.5 and later 20 GB
Threat Protection for Email
Trend Micro TippingPoint Advanced 5.5 and later 20 GB
Threat Protection Analyzer
Deep Discovery Director 1.1 and later 20 GB
Deep Discovery Web Inspector 2.0 and later 20 GB

Procedure

1.

2.

On the VirtualBox Manager screen, power off the virtual machine.

Note

Vertify that the CD/DVD drive is empty before poweting off and exporting.

Go to File > Export Appliance.
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The Export Virtual Appliance window appears.

Export Virtual Appliance

Virtual machines to export

Please select the virtual machines that should be added to the appliance. You can select more than one. Please note that these machines have to be turned
off before they can be exported.

win10_office2016_xBd

Expert Mode Cancel

FIGURE 3-41. Export Virtual Appliance

3. Select the virtual machine image to export and click Next.
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4.

5.

The Storage settings screen appears.

€ Export Virtual Appliance

Appliance settings

Please choose a format to export the virtual appliance to.

The Open Virtualization Format supports only ovf or ova extensions. If you use the ovf extension, several files will be written separately. If you use
the ova extension, all the files will be combined into one Open Yirtualization Format archive,

The Oracle Cloud Infrastructure format supports exporting to remote doud servers only. Main virtual disk of each selected machine will be uploaded to
remote server.

Format: | Open Virtualization Format 1.0 -

Please choose a filename to export the virtual appliance to. Besides that you can specify a certain amount of options which affects the size and content of
resulting archive.

File: |C: Wsersiadministrator \Documents\win 10_office2016_x&4.ova | @

MAC Address Policy: |Indude only NAT network adapter MAC addresses -
Additionally: [] Write Manifest file
[ tndude 150 image files

FIGURE 3-42. Storage settings

Configure the following:
. File: Accept the default name and path or click :L;:-SJ to select a different file.

. Format: Select OVF 1.0.

Important

Format options include OVF 0.9, 1.0 and 2.0. Virtual Analyzer does not
support OVF 2.0.

Click Next.
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The Appliance settings screen appears.

< Export Virtual Appliance

Virtual system settings

This is the descriptive information which will be added to the virtual appliance. You can change it by double dlicking on individual lines.

Wirtual System 1
{3’ MName win10_office2016_x64
@ Product
&) Product-URL
@ Vendor
&) Vendor-URL
@ Version
@ Description

@ License

Restore Defaults Export Cancel

FIGURE 3-43. Appliance settings

6.  Verify that the License field is empty and then click Export.
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VirtualBox creates the OVA file.

Iﬁ Exporting Appliance ...: Export appliance 'ChUsers] Docume...

Exporting to disk image 'win10_office2016_x&64-disk001.vmdk' ... (2/3)

B 8% X

10 minutes remaining

FIGURE 3-44. Disk Image Export Progress Bar
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Chapter 4

Virtual Analyzer Image Preparation
Tool

Learn how to use the Virtual Analyzer Image Preparation Tool in the following topics:

Overview on page 4-2
Image Validation and Configuration on page 4-4
System Requirements on page 4-3

Using the Tool on page 4-5

Troubleshooting Common Issues on page 4-20
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Overview

The Virtual Analyzer Image Preparation Tool facilitates the creation of custom sandbox
images.

TABLE 4-1. Features

FEATURE DESCRIPTION

Image creation Create custom sandbox images for the following products:

«  Deep Discovery Inspector 3.8, 3.8 Service Pack 1, 3.8
Service Pack 2, 3.8 Service Pack 3, 3.8 Service Pack 5, 5.0,
and 5.1

. Deep Discovery Email Inspector 2.1, 2.5, 2.5 Service Pack 1,
2.6,3.0,3.1,and 3.2

Deep Discovery Analyzer 5.1, 5.5, 5.5 Service Pack 1, 5.8,
6.0, and 6.1

«  TippingPoint Advanced Threat Protection for Networks 3.8
SP2, 3.8 Service Pack 3, and 3.8 Service Pack 5

TippingPoint Advanced Threat Protection for Email 2.5, 2.5
Service Pack 1, and 2.6

+  TippingPoint Advanced Threat Protection Analyzer 5.5, 5.5
Service Pack 1, and 5.8

Deep Discovery Director 1.1, 2.0, 3.0, and 3.5
Deep Discovery Web Inspector 2.0 and 2.2

Image validation The tool validates and configures OVA files created using
and configuration VirtualBox.
Note

For images created using VMware, see OVA File Creation
Using Converted Virtual Hard Disk Drives on page 3-1.
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System Requirements

TABLE 4-2. System requirements

REQUIREMENT SPECIFICATION

Host operating Build 3.8.1009 and later:

system Windows 7 (32-bit and 64-bit)
Windows 8 (32-bit and 64-bit)
Windows 8.1 (32-bit and 64-bit)
Windows 10 (32-bit and 64-bit)

Build 3.8.1240 and later:

+  Windows Server 2003/2003 R2

+  Windows Server 2008/2008 R2

. Windows Server 2012/2012 R2

™ Important

Microsoft .NET Framework 4.0 or later must be installed on
the host operating system.

Virtualization Oracle™ VM VirtualBox 4.3 or later (except 5.0.6)
application

~ Important

“*" The tool does not support VirtualBox 5.0.6 because a

defect prevents the first serial port from functioning
properly. Trend Micro recommends using VirtualBox 5.0.7
or later.

For virtual machine images created in VMware, see
Creating OVA Files Using Converted Virtual Hard Disk
Drives on page 3-2.
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REQUIREMENT SPECIFICATION
Hardware The hardware virtualization in the motherboard BIOS of the host
virtualization operating system must be enabled to support Windows 8/8.1/10

or any 64-bit guest operating systems.

Note

The tool can detect hardware virtualization only on
Windows 8/8.1/10 hosts.

Image Validation and Configuration

The tool automatically validates and configures the following VirtualBox image settings.

TABLE 4-3. Validating and configuring image settings

SETTING CORRECT CONFIGURATION
Admin password 1111
Keyboard layout Enhanced keyboard layout: 101
Found New Hardware Disabled
Wizard
Disk defragmentation Disabled
.NET Optimization Disabled
CPU count 1
Memory size +  Windows XP or Windows Server 2003: 512 MB
+  Other operating systems: 1024 MB
PAE/NX Enabled
Hardware virtualization VT-x/AMD-V and nested paging enabled
Audio driver Enabled
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SETTING CORRECT CONFIGURATION

Windows SMB service Enabled
(TCP port 445)

File and Printer Sharing for | Enabled
Microsoft Networks

AutoPlay Enabled in Windows 7/8/8.1/10
Microsoft Office macros Enabled
Network adapter settings Obtain an IP address automatically

O Important
L *

The tool checks but does not modify the Windows and Office versions. Verify that the
image meets the requirements before running the tool.

Using the Tool

Procedure

1.  Obtain a copy of SandboxWizard. zip from your support provider.

2.  Extract the package content to a local folder. Go to the folder and then open
SandboxWizard.exe.
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The introduction screen appears.

Virtual Analyzer Image Preparation Tool

Virtual Analyzer Image Preparation Tool

The Virtual Analyzer Image Preparation Tool facilitates the crestion of custom sandbox images.
Important: Using this teol may decrement Windows and Office activations.

View the readme

v3.3.1191 (&) 2019 Trend Micro Inc

Cance <Back

FIGURE 4-1. Introduction screen

3. Click Next.

The tool checks if the computer meets the system requirements, and then the
System Requirements screen appears.
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Virtual Analyzer Image Preparation Tool - O *

System Requirements

@ All requirements have been met. Click Mext to continue using the tool,

Mote: The Teol can detect hardware virtualization only on Windows 8 or later hosts.

VirtualBox 4.3 or newer: 6.0.4

CPU hardware virtualization: Enabled

FIGURE 4-2. System Requirements screen

4. Click Next.
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The Specify Virtual Machine screen appears.

Virtual Analyzer Image Preparation Tool - O *

Specify Virtual Machine

The tool will check the image for required applications, and then adjust settings if
necessary.

Important: Using this tool may decrement Windows and Office activations. It is

recommended to activate the products in the guest operating system to ensure normal
operation of the image.

® Use an OVA image (exported from VirtualBox)

) Select a VM on VirtualBox

OWA file: Browse

Mote: The tool will import the selected OWA file into VirtualBox for validation
and preparation. Depending on the size of the OVA file, the resulting VM can
consume several gigabytes of disk space.

FIGURE 4-3. Specify Virtual Machine screen

5. Specify an OVA file or a virtual machine instance running on VirtualBox.

a.  Select one of the following:

Use an OVA image (exported from VirtualBox): Select this option if
you converted a VMware image and then packaged it as an OVA file.

For details, see OV"A File Creation Using Converted V'irtual Hard Disk Drives
on page 3-1.
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O Important
o

Open Virtualization Format (OVF) is a cross-platform standard for
packaging and distributing software to be run in virtual machines. OVF
enables the creation of ready-to-use software packages (operating systems
with applications) that require no configuration or installation.

An OVF package consists of several files that can be packed into a single
archive file with the extension .ova. Virtual Analyzer supports only
image files in the OVA format.

. Select a VM on VirtualBox: Select this option if you want to create an
image based on an existing virtual machine on VirtualBox.
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For example:

Virtual Analyzer Image Preparation Tool - O *

Specify Virtual Machine

The tool will check the image for required applications, and then adjust settings if
necessary.

Impertant: Using this tool may decrement Windows and Office activations. Itis
recommended to activate the products in the guest operating system to ensurs normal
operation of the image.

() Use an OVA image (exported from VirtualBox)

® Select a VM on VirtualBox

VirtualBox VM: | win10_office_x64

Clone VM before processing

nce Mext>

FIGURE 4-4. Specify Virtual Machine screen - Select a VM on
VirtualBox

b.  Seclect Clone VM before processing to create a new copy of the virtual
machine with its own set of individual snapshots. Cloning allows quick
creation of duplicate environments for testing. You can run as many clones as
the memory and processors on the system allow.

6. Click Next.
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The Sandbox Preparation screen appears.

tual Analyzer Image Preparation Too

Sandbox Preparation

29% complete..

Importing the image to VirtualBox...
Attaching the serial port...

Checking the wirtual machine settings...
Powering up the virtual machine...
Checking a few Windows settings...

<Back Mext=

FIGURE 4-5. Sandbox Preparation screen

The tool modifies incorrectly configured settings. For a list of settings that the tool
validates, see Image 1 alidation and Configuration on page 4-4. For solutions to issues
that occur during this phase, see Troubleshooting Conmon Issues on page 4-20.

Perform one of the following actions depending on the screen that appears:
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«  The Sandbox Ready screen appears when the tool has successfully validated
and configured all settings.

O

sandbox Ready

A valid image has been prepared successfully. Export the image to an OVA file now or use
VirtualBox to export it later.

Original image file:  7_En_win10rs3en_offices_noab.ova

Windows: Microsoft Windows 10 Pro Build 16299 32bit

VM settings: Done

Internet Explorer.  Internet Explorer 11.15.16239.0

Office: Office 2013,2016

Adobe Reader: Adobe Reader 11.0.02

Adobe Flash: Adobe Flash Player Active ¥ 18.0.0.203
.NET: NET Framewark 4.7.02556

Wiew detailed log

I

<Back Mext>

o
=
a

FIGURE 4-6. Sandbox Ready screen

Click Next to continue.
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. The Products Not Activated screen appears when the tool detects that
Windows and/or Office are installed but not activated.

Virtual Analyzer Image Preparation Tool - O *

Products Mot Activated

Windows and/or Office are not activated. It is recommended to activate the products in
the guest operating system to ensure normal operation of the image. Click Retry after
activating the products.

How to activate products

Original image file:  MAK_ID25_win10en_offices_noab_x64.ova

e Microsoft Windows 10 Enterprise Build 10240 84bit (not
activated)
VM settings: Done

Internet Explorer.  Internet Explorer 11.0.10240.16384

Office: Office 2010,2013 (not activated)
Adobe Reader Adobe Reader (will be installed)
Adobe Flash: Adobe Flash Player Active ¥ 18.0.0.203
NET: .NET Framewark 4.6.00079

View detailed log

Cance <Back Mext>

FIGURE 4-7. Products Not Activated screen
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Click How to activate products to learn to how to activate Windows and/or
Office in the guest operating system.

How to activate products >

Step 1: Switch to VirtualBox and activate Windows and/or Office,
Step 2: Switch to the Virtual Analyzer Image Preparation Tool,
Step 3: Click Retry.

OK

FIGURE 4-8. How to activate products dialog

Click Retry after activating the products, or click Next to continue without
activating the products. It is recommended to activate the products in the
guest operating system to ensure normal operation of the image.
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The Sandbox Preparation Unsuccessful screen appears when the tool is
unable to fix issues encountered during preparation.

Virtual Analyzer Image Preparation Tool

Sandbox Preparation Unsuccessful

® One or more Office products are not installed. Trend Micro recommends installing all Office
products in the guest operating system to ensure normal operation of the image.

WM Name; MAK_ID27_win10t2en_offices_noab
Windows: Microscft Windows 10 Enterprise Build 10586 32bit
WM settings: Daone

Internet Explorer:  Internet Explorer 11.103.10586.0

Office: Office (not installed)
Adobe Reader: Adobe Reader (will be ins
Adobe Flash: Adobe Flash Player Active X 18.0.0.203
.NET: NET Framework 4.6.01038
View detailed log Retry
| Cancel | | <Back Mext>

FIGURE 4-9. Sandbox Preparation Unsuccessful screen

Click View detailed log and perform any recommended actions before
running the tool again.

Click Retry to try preparing the sandbox again, or Cancel to exit the tool.
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If no issues arise, the Specify the OVA image path and file name screen

appears.

Virtual Analyzer Image Preparation Tool - O *

Specify the OVA image path and file name

Specify a path and file name for the new image. By default, the image is saved in the same
folder as the tool.

Path and file name: | CAVAIPT ova\[VAIPTIwin10_rs2_office_2016_x64ova ||

Estimated image size: 8G

104 GB on diskiC)

Available disk space:
0 GB on disk(F:\)

Remove the image from VirtualBox after exporting
[] Compress the image for uploading to Deep Discovery Director

ce <Back Mext=

FIGURE 4-10. Specify OVA image path and file name screen

If issues arise and are not resolved, see Troubleshooting Common Issues on page 4-20.
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ﬁ Note

SandboxWizard.exe saves logs in the \ 1og folder where you run the tool. Logs
use the following naming convention: d: \SandboxWizard\1log\VATool~
yyyymmddhhmmss output.txt

For example: d: \SandboxWizard\log
\VAT001-20170925025520_output.txt

Configure the following settings:

«  Specify the path and file name that the tool uses when saving the OVA file.

ﬁ’ Note

The tool uses the following naming convention when saving an OVA file:
VAT001-20170925025520.0va

. (Optional) Enable Remove the image from VirtualBox after exporting.

Disable this option if you want to keep the image in VirtualBox even after
exporting.

Important

Unused images consume valuable disk space may impact performance.

+  (Optional) Enable Compress the image for uploading to Deep Discovery
Director.

Important

Only Virtual Analyzer images compressed in TAR format by the Virtual
Analyzer Image Preparation Tool can be uploaded to and deployed from Deep
Discovery Director.

Click Next.
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The Export the image to OVA screen appears and the tool exports the OVA file.

Virtual Analyzer Image Preparation Tool - O *

Exporting the image to OVA...

8% complete..

Cancel <Back MNext>

FIGURE 4-11. Export the image to OVA screen
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The OVA Image Ready screen appears when the export process completes.

Virtual Analyzer Image Preparation Tool — O *

OVA Image Ready

@ The OVA image file has been created successfully. The image is ready for use in Virtual

Analyzer.

Image file: CAD\VAIPT ova\VATool-20171011103003.0va
Windows: Microseft Windows 10 Enterprise Build 15063 64bit
VM settings: Done

Internet Explorer:  Internet Explorer 11.0.15063.0

Office: Office 2016

Adobe Readen Adobe Reader 8.9 11 (will be installed)
Adobe Flash: Adobe Flash Player Active ¥ 18.0.0.203
MNET: JMET Framework 4.7.02046

Back to Home <Back Mext>

FIGURE 4-12. OVA Image Ready screen

10. Click the Close button in the upper right corner to exit the tool or click Back to
Home to create another image.
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Troubleshooting Common Issues

TABLE 4-4. Common Issues When Using the Tool

IssuE CAUSE RECOMMENDED ACTION

Unable to upload an | The image does not | Verify that the OVA image is between 1 GB
QOVA file. meet the minimum and 20 GB in size.

or maximum size
requirements.

Unable to prepare a | The image was not | Install a supported VirtualBox version. For

virtual machine created using details, see System Requirements on page
image. VirtualBox. 4-3.
VirtualBox is not For virtual machine images created in
installed on the VMware, see Creating OVA Files Using
computer. Converted Virtual Hard Disk Drives on
page 3-2.
The image uses an | Use a supported operating system. For
unsupported details, see Required Software on page
operating system. 2-2.
VirtualBox is Refer to the VirtualBox documentation.
unresponsive.

https://www.virtualbox.org/manual/
ch12.html#idp54271008



https://www.virtualbox.org/manual/ch12.html#idp54271008
https://www.virtualbox.org/manual/ch12.html#idp54271008
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ISSUE CAUSE RECOMMENDED ACTION
Unable to start the Settings are Open the imported image using VirtualBox
VirtualBox incorrectly and verify the following Storage settings.
installation CD/ configured. .
DVD. +  Select Controller: IDE and verify that

the specified type is PlIX4.

@ winl0_ffce2016.x4 - Setings T x

T Use Fost1/0 Cache

BEQS
o[ o

FIGURE 4-13. Controller: IDE must
be set to PlIX4

Select the optical disc icon and verify
that the specified CD/DVD drive is
IDE Secondary Master.

23 win10_office2016.164 - Setings 7 X

BEe

FIGURE 4-14. CD/DVD drive is set to
IDE Secondary Master
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ISSUE

CAUSE

RECOMMENDED ACTION

Unable to enter the
desktop of the guest
operating system.

Group policy
settings are
incorrectly
configured.

Click OK on the Virtual Analyzer Image
Preparation Tool Test screen to enter the
desktop of the guest operating system.

. Windows 7 Professional
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IssuE CAUSE RECOMMENDED ACTION

Unable to start AutoPlay settings 1. Open VirtualBox.
SandboxWizard.exe | are incorrectly

in the guest image. | configured. 2. On the VirtualBox Manager screen,

click ;ﬁ to power on the image.

3. On the guest operating system,
perform the following:

a. Go to Control Panel > Hardware
and Sound > AutoPlay.

b. Select Install or run program
from your media from the
Software and games drop-down
menu.

c. Click Save.

d. Open the Local Group Policy
Editor.

e. Go to Computer Configuration >
Administrative Templates >
Windows Components >
AutoPlay Policies.

f.  Select Not configured to disable
AutoPlay.
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Sample Logs
Preparation successful. Missing app detected.

Trend Micro(TM) Virtual Analyzer Image Preparation Tool
Detailed Log

Result Preparation successful
Completed 2018-07-01 @7:53:06
Virtual machine name MAK_win7splen_offices_noab_ID13(in VirtualBox) - OK

2. Hardware settings

Processor count 1 - 0K
Memory size 1824 - 0K
Host Audio Driver "none" - 0K
Audio Controller "none" - 0K
Nested Paging “on™ - 0K
Large Page "off" - 0K
CPU Execution Cap lee - OK
PAE/NX “on™ - 0K
ACPI “on™ - 0K
HPET “off" - 0K
I/0 APIC “on™ - 0K
Use UTC "off” - 0K
Chipset "ich9™ - 0K
UsB “on™ - 0K
USB ECHI "off" - 0K
VT-x "on™ - OK
Porting Device "usbtablet™ - 0K
NIC "nat” - 0K
IDE Controller - 0K
CD/DVD drive - 0K
VMDK /DI - 0K
NIC - 0K

3. Windows and applications™

Windows Microsoft Windows 7 Enterprise SP1 Build 7601 32bit - OK

Office
Microsoft Word Microsoft Word 20@3,2087 - installed
Microsoft Power Point Microsoft Power Point 2003,2087 - installed
Microsoft Excel Microsoft Excel 2083,2807 - installed
Microsoft Publisher Microsoft Publisher 20@3,2807 - installed

NET .NET Framework 4.0.30319 - 0K

Internet Explorer Internet Explorer 9.0.8112.16421 - 0K

Adobe Flash Adobe Flash Player - will be install

Adobe Reader Adobe Reader - will be install
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Preparation unsuccessful. Some items must be fixed manually.

Trend Micro(TM) Virtual Analyzer Image Preparation Tool
Detailed Log

Result Preparation unsuccessful. Some items need to be fixed manually.
Error Reason One or more Office products are not installed.

Completed 2018-67-83 1@:51:@9

Virtual machine name MAK_ID27_winl@t2en_offices_noab(in VirtualBox) - OK

2. Harduare settings

Processor count 1 - 0K
Memory size 1024 - 0K
Host Audio Driver "null" - 0K
Audio Controller “null” - 0K
Nested Paging "on™ - 0K
Large Page "off" - 0K
CPU Execution Cap 1e@ - 0K
PAE/NX “on" - 0K
ACPI "on" - 0K
HPET "on" - 0K
I/0 APIC “on™ - 0K
Use UTC "off" - 0K
Chipset "ichg" - 0K
UsB "on™ - 0K
USB ECHI e - 0K
VT-x “on" - 0K
Porting Device "usbtablet” - 0K
NIC "natnetwork” - 0K
NAT Network "NatNetwork™ - 0K
IDE Controller - 0K
CD/DVD drive - 0K
VMDK/VDI - 0K
NIC - 0K

3. Windows and applications™

Windows rosoft Windows 1@ Enterprise Build 18586 32bit - installed
Office
Microsoft Word Microsoft Word - Error: not installed
Microsoft Power Point Microsoft PowerPoint 2016 - installed
Microsoft Excel Microsoft Excel 2016 - installed
Microsoft Publisher Microsoft Publisher 2616 - installed
.NET .NET Framework 4.6.01638 - 0K
Internet Explorer Internet Explorer 11.103.18586.8 - 0K
Adobe Flash Adobe Flash Player Active X 18.8.0.203 - 0K

Adobe Reader Adobe Reader - will be installed
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